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About this Practice Workbook... 
 

• This PDF file includes bookmarks providing an overview of the document. Click on the 
bookmark to quickly jump to any section in the file. You may have to turn on the 
bookmark function in your PDF viewer, such as Adobe Reader. 

 

• The dataset used throughout this module uses English units and US Survey Feet. 
 

• Each module in this series is self-contained. You can jump to any module and begin the 
exercises. 

 

• This training module uses the DOT-US North Carolina WorkSpace and the R-2635C 
(Training) Workset installed. It is very important that you select the correct WorkSpace, 
WorkSet and Desktop Icon/Discipline/future Role NCDOT_Roadway when working the 
exercises in this course and to set the NCDOT_USE_LOCAL_WORKSETS = (Load Value) 
to be L2 in the NCDOT_WorkSets.inp file on your desktop to be able to access this 
WorkSet. 

 

• The tool tips and help were copied from the Bentley Online Help. See this link for the 
complete list of tools and common usage. 
 
OpenRoads Designer CONNECT Edition Help (bentley.com) 

 

• This workbook was written with the release of OpenRoads Designer 10.09.00.91 (2020 
Release 3 Update 9). 

 

• This workbook has been updated for OpenRoads Designer 10.10.XX.XX (2021 Release 1 
Update 10). 
 

 
 

 

 

 

  

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v11/en/GUID-1B18BC16-7361-4DA1-BC57-D8A9EEF3F9E7.html
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Computer Specifications 
Designing roadways using ORD requires a computer that has more powerful hardware and 
software specifications.  Minimal and desirable specifications are listed on NCDOT CADD 
Services’ website at the link below and will be continually updated as specifications change.  
Please refer to this list and ensure that your computer is properly equipped before proceeding. 

 
NCDOT CADD Services 

 AWAITING WEBSITE TO BE REVISED BY CADD SERVICES TO ADD COMPUTER SPECIFICATIONS 

 
Overview 

OpenRoads CONNECT Edition is the successor to Bentley’s MicroStation/GEOPAK software and 

is a comprehensive, multi-discipline 3D modeling application that advances the delivery of 

roadway projects from conceptual design through construction. OpenRoads blends traditional 

2D engineering workflows for plan, profile, and cross-sections with 3D parametric modeling to 

enable the model-centric creation of all design deliverables.  

Before designing an NCDOT project using Open Roads Designer (ORD), the user must: 

• Ensure the computer meets minimum hardware specifications 

• Have the current NCDOT CONNECT workspace loaded 

• Have the standard project folder structure created using NCDOT’s folder naming 

convention using either 

o ProjectWise 

o Network Drive (ProjectStore)  JASON STILL INCLUDE? 

o Local Drive (C:) 

• Create ORD .dgn files 

o Using the correct seed file 

o Named according to NCDOT’s ORD standard naming conventions 

o And placed in the appropriate subdirectory folder 

 

Files need to be referenced to each other for the proper operation of ORD and logical reference 

names assigned to these files for printing to work properly. Proper naming and referencing of 

the files are far more important in ORD than previous versions of MicroStation and GEOPAK.  

Renaming files or moving their location can result in links being broken between design files 

that are vital for ORD to work correctly and is therefore not recommended that you rename or 

move files. 

https://connect.ncdot.gov/resources/CADD/Pages/default.aspx
https://connect.ncdot.gov/resources/CADD/Pages/default.aspx
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An understanding of these three concepts used in ORD, WorkSpace, WorkSet, Role? and 

WorkFlow is beneficial for designing in ORD and will be explained in this Module 1.  Note the 

hierarchy of the ORD customization containing these concepts represented in the diagram 

below. 
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New ORD Concepts 

 
1. Multiple Models 
In the past, the designer had one Model inside of a design file and were perhaps blissfully 
ignorant that there could be more. The concept of multiple Models within a design file will be 
used often in ORD.  It is helpful to think of a Model as a design file within a design file or 
another analogy to think of is that a Model in a design file is like Worksheets in a Workbook in 
MS Excel.  The Model is a container that the design elements are drawn in. 
 
This term Model should not be confused with the ORD 3D Design Model of the proposed 
surfaces that the designer produces with the ORD software.  It is likely that the designer will 
have an ORD 3D Design Model of the proposed surfaces drawn into a 3D Model inside of a 2D 
design file. This concept will be further explored in the Corridor Modeling Module in NCDOT’s 
ORD Training 
 
Looking under the Home Tab → Primary Tool Group → Models Tool in this file shows an 
example of multiple Models used in a design file to contain the design as well as plan sheets in 
one file.  This concept will be further explored in the Sheeting Module in NCDOT’s ORD 
Training. 

Multiple Models in a Design File 
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Below is an example of a 3D Design Model produced with the ORD software. 
 

3D Design Model 
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A new concept introduced in ORD is the use of different types of Models within a design file.  
ORD uses Design, Drawing, and Sheet Models to carry the project from design through plan 
sheet production.  Each type of Model has a distinguishing background color for easy 
identification when the user is in it.  This concept will be further explored in the Sheeting 
Module in NCDOT’s ORD Training. 

 

 
 
2. 3D Models 
As we begin using ORD where the main goal is to produce a 3D model, it can be confusing 
whether to create and work in a 2D or 3D design file.  The best “rule of thumb” to follow when 
creating design files is to ALWAYS CREATE AN ORD DESIGN FILE USING THE 2D SEED FILE 
UNLESS YOU ARE CREATING A FILE FOR PROCESSING SURVEY DATA OR CREATING A TERRAIN 
MODEL. 
 
A new concept that is important to understand when using ORD is the automatic creation of a 
new 3D model inside of the working design file by ORD.  This happens when the user is in a 2D 
Model and initiates an ORD command that calls a model in a design file that contains 3D 
attributes such as vertical elevation.  Once a vertical component is introduced to the 2D design 
model such as adding an active vertical alignment (proposed profile) or making the referenced 
terrain model active, ORD will create a companion Default-3D model and it will be referenced 
to the design file to store and process the 3D information in.  This allows the user to be in the 
2D model and use the 2D model as an interface to develop and edit the 3D model. This concept 
will be further explained in the Existing Terrain, Corridor Modeling, and Sheeting Modules in 
NCDOT’s ORD Training.    
 
3. Design Element Creation Workflow 
Another very important concept the user must be aware of is the new workflow for drawing a 
majority of the design elements into a file.  In the past, the user would draw 2D design 
elements into a 2D model inside of a 2D design file to begin the design and later produce a 3D 
design model of those 2D elements in a separate 3D design file using templates.   
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In ORD, the user will begin the design by creating a 2D Corridor Modeling design file                   
R-2635C_RDY_CMD.dgn that contains a 2D default model.  The user will create a corridor using 
ORD and apply a roadway template to that corridor in the 2D model in the 2D design file. When 
the corridor is processed, a 3D model will automatically be created within the same 2D design 
file.  A 3D model view can then be opened inside of the 2D design file to view the 3D Design 
Model created with the template.  At this point the CMD file now has both 2D and 3D Models 
and Views. In addition to the 3D design model that is created when processing the template 
along the corridor, a majority of the project’s 2D design elements such as edge of pavements 
are also automatically drawn in the default 2D model with correct symbology that can be used 
in plan sheet production. 
 
Once the majority of the design elements have been automatically drawn into the 2D model by 
processing the template, the user will then draw additional design details not provided by the 
template such as a right turn bay into a 2D model using Construction Class line symbology that 
can be read by the template.  This 2D model can be the 2D model located in the CMD design file 
or another 2D model located in another file such as the R-2635C_RDY_DSN.dgn file.  The user 
will then reprocess the template which will read the additional construction class design 
elements from the 2D model, draw them in the 3D model, and redraw them back into the 2D 
model using the correct Primary Class symbology which can also be used in plan sheet 
production.  This workflow makes the 2D and 3D models co-dependent on each other.   
 
This concept will be further explained in the Corridor Modeling Modules in NCDOT’s ORD 
Training.  
 
 
4. Features and Feature Definitions 
Throughout ORD, the user will encounter Features and Feature Definitions.  A Feature is a 
measurable thing that is part of your design such as Centerline, Edge of Pavement, Catch Basin, 
or a Terrain Model.  A Feature has certain properties that define how its created and behaves in 
different contexts and that Feature is defined by a Feature Definition.  Feature Definitions are 
similar to but more powerful than the Drafting Standards set in Plan Graphics in earlier Bentley 
software.  A Feature Definition describes what a Feature is and sets the symbology for the 
Feature.  These properties allow ORD to model the Feature and display it differently according 
to the context such as plan, profile, cross section, or 3D views.   This is accomplished through 
Element Templates and Annotation Groups. 
 
This concept will be further explained in the Horizontal Alignment and Corridor Modeling 
Modules in NCDOT’s ORD Training.  
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NCDOT ORD Workspace Setup 

A WorkSpace is a collection of files where organizations like DOT’s store their standards such as 

resources, libraries, custom applications, levels, cells, line styles, feature definitions, macros 

(BAS/VBA/MDL), pen tables/design scripts, color table/book, unit definitions (miles/feet English 

vs. kilometers/meters Metric), design standards, seed files, etc.  A WorkSpace is the “parent” of 

a WorkSet.  Each WorkSpace has one or more Configuration File(s) that specify locations for 

WorkSpace standards and the WorkSets associated with the WorkSpace.   

 

 

 

Storing WorkSpaces and WorkSets on ProjectWise is referred to as Managed WorkSpaces. 

WorkSpaces and WorkSets will be created automatically by NCDOT when the project is initially 

created on ProjectWise. The user will not need to create either (though some manual file 

renaming may be necessary).  

Storing WorkSpaces and WorkSets outside of ProjectWise is referred to as Nonmanaged 

Workspaces.  While using Nonmanaged WorkSpaces, the WorkSets will be created and stored 

outside of ProjectWise on the local C:\ Drive as described below. 

 

 

1. Loading NCDOT WorkSpace and associated files is a three-step process. 
 
A. NCDOT ORD WorkSpaces are loaded using the UpdateConnectWS program that NCDOT 

provides and will create this folder C:\MICROSTATION_CONNECT_WORKSPACE and the 
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WorkSpace contents.  The same UpdateConnectWS program can also be used to update 
your workspaces as revisions to the WorkSpaces are posted. 

 
In addition to the WorkSpace files, other files need to also be loaded on your computer.  
These files are loaded onto your computer with two zip files that NCDOT provides.    

 
B. The first zip file NAME.zip??? overwrites the default ConfigurationSetup.cfg and 

WorkSpaceSetup.cfg files in the C:\ProgramData\Bentley\OpenRoads Designer 

CE\Configuration folder allowing the user to access both the default Bentley Workspaces 
and the NCDOT WorkSpaces.  If a user has more than one version of ORD on their 
machine, then there must be a separate ConfigurationSetup.cfg file for each version of 
ORD 

 
C. The second zip file NAME.zip??? creates the C:\Projects folder and its subdirectories 

including the B-0000 project folder.  The intention of including this project is to provide 
an example NCDOT ORD project showing NCDOT’s ORD project folder structure.   
Information within the folders will grow as more content is made available.  Users can 
navigate to find examples of what files are stored in each Unit, the file’s contents, 
deliverables and how the units’ files interact with each other.  This B-0000 project will 
also serve as a template to be replicated when creating WorkSets.  

 

 
Video 1-1 Setup WorkSpace 

HTTP LINK PLACEHOLDER 
 
2. Workspace Setup 

 
A. If any old Connect WorkSpace folders, desktop icons, and desktop .inp files exist that 

were loaded prior to May 2021, delete them from the computer to ensure that all of the 
WorkSpace is updated on the local drive.  
 

• Delete this folder from your computer C:\MICROSTATION_CONNECT_WORKSPACE 
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• Delete any previously installed ORD desktop icons and .inp files such as the NCDOT 
Roadway icon and NCDOT_Worksets.inp file from your desktop if present. 

 

  
 

B. Load the NCDOT UpdateConnectWS program which creates or updates the WorkSpace 
on the user’s computer.  

• Go to this webpage to download the program 
https://connect.ncdot.gov/resources/CADD/Pages/default.aspx 

• Choose the UpdateConnectWS link in the lower right of the webpage to load the 
program onto your computer. Direct Link: 
https://connect.ncdot.gov/resources/CADD/Applications/UpdateConnectWs/UpdateConne
ctWs.application          

• Choose Install if prompted 
 

 
 

https://connect.ncdot.gov/resources/CADD/Pages/default.aspx
https://connect.ncdot.gov/resources/CADD/Applications/UpdateConnectWs/UpdateConnectWs.application
https://connect.ncdot.gov/resources/CADD/Applications/UpdateConnectWs/UpdateConnectWs.application
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• Choose the icon that the installer created on your desktop to launch the program 
 

 
 

• This dialog box will launch and the program will compare the WorkSpace files on 
your local computer to the WorkSpace files stored on NCDOT’s server.  The red 

exclamation Status points ! indicate that the Workspace files on your local 

computer do not match the version on NCDOT’s server.  If this is the user’s first time 
loading the WorkSpaces, then all of the WorkSpaces Status will indicate this.    

Check the box next to the red exclamation Status point  !  next to DOT-US North 

Carolina and choose Update and ALL of the WorkSpaces below that have an 

exclamation point  !  will be updated. 

 

 
 

• If this is the initial load of the workspaces, this process may take 30 minutes or more 
depending on your network connection.  Once the files are copied from NCDOT’s 
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server, The red exclamation points  !  will turn to green check marks  ✓  indicating 

an updated workspace.  Occasionally, the program does not update every file on its 
initial pass and must be run again as shown below. 

 

 
 

• If this happens, Check the update box and choose update again to complete update 

shown by all green check marks  ✓  .    
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3. Additional Files Setup 
 
A. Go to this webpage 

https://connect.ncdot.gov/projects/Roadway/Pages/Technical-Resources.aspx  

 
B. In the lower right under CADD → Workstation → Resource Type: Files, download 

NAME.zip??? file CHECK BACK WITH OAK TO DETERMINE NEW NAME FOR .ZIP FILE 
THAT ONLY LOADS .CFG IN PRORGAM DATA and NOT WORKSPACES 
Launch the zip file to load or update the .cfg files in the Program Data folder. 
 

C. Choose “Yes, unzip the files to a folder I choose”  
 

REDO SCREENSHOT ONCE OAK CREATES THE TWO NEW ZIP FILES 

 
 

D. Choose the C:\ drive and Unzip.  It is very important to unzip this to the C:\ Drive in 
order for the WorkSpaces to work properly.  

 

https://connect.ncdot.gov/projects/Roadway/Pages/Technical-Resources.aspx
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B. Go back to this webpage 

https://connect.ncdot.gov/projects/Roadway/Pages/Technical-Resources.aspx  

 
E. In the lower right under CADD → Workstation → Resource Type: Files, download 

NAME.zip??? file CHECK BACK WITH OAK TO DETERMINE NEW NAME FOR .ZIP FILE 
THAT ONLY ADDS C: PROJECTS, AND NOT WORKSPACES 
Launch the zip file to load create the C:\Projects folder.  The C:\Projects folder contains 
a sample project B-0000 and its associated B-0000.cfg and B-0000.dgnws files.  
  

F. Choose “Yes, unzip the files to a folder I choose”  
 

REDO SCREENSHOT ONCE OAK CREATES THE TWO NEW ZIP FILES 

https://connect.ncdot.gov/projects/Roadway/Pages/Technical-Resources.aspx
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G. Choose the C:\ drive and Unzip.  It is very important to unzip this to the C:\ Drive in 
order for the WorkSpaces to work properly.  
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H. Copy the new desktop files from the following WorkSpace folder to your desktop 
 
C:\MICROSTATION_CONNECT_WORKSPACE\Configuration\WorkSpaces\DOT-US North 
Carolina\Desk 

  

• NCDOT Roadway   (or any other unit specific icon) 

• NCDOT_WorkSets.inp  (required) 

• NCDOT ---ALL---   (optional to load all NCDOT Unit’s workspaces) 
 

 
 

• This icon is to be used to properly enter ORD design files to ensure that NCDOT 
WorkSpaces and project WorkSets are called when entering the file.  These icons are 
temporarily necessary until Bentley allows Role designations under their workspaces 
that can be assigned to each discipline. 

 

 
 

I. Notes 

• A detailed explanation of loading and configuring WorkSpaces is available in this 
video 

 
Video 1-2 NCLUG Tech Talk NCDOT Workspaces - YouTube 

 

• If you are loading WorkSpaces onto a computer whose desktop is being backed up 
on One-Drive, the NCDOT_WorkSets.inp file used by the desktop launching icons 
must be located on the local system desktop located under C:\Users\(USER)\Desktop 
or the WorkSet will not launch properly. You can create a shortcut from your One-
Drive desktop to call the NCDOT_WorkSets.inp file for editing. 

• There is no need to modify the WorkSpaceSetup.cfg file as in the past. This file 
should NOT be edited from its default values. 

https://www.youtube.com/watch?v=BwFvOaa0gME&feature=youtu.be
file:///C:/Users/dsarvis/Downloads/4.%20Create%20WorkSet%20in%20ProjectStore%20R%20Drive.mp4
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• For OpenRail and OpenBridge to work together with OpenRoads using the same 
WorkSpace, the ConfigurationSetup.cfg file for each CONNECT civil platform is 
automatically modified with the same value when the user uses the NAME?.zip file. 
This are the standard installation folders which contain the .cfg files that are 
required for proper functionality. 
 

C:\ProgramData\Bentley\OpenRoads Designer CE\Configuration 
C:\ProgramData\Bentley\OpenRail Designer CE\Configuration 
C:\ProgramData\Bentley\OpenBridge Designer CONNECTEdition\OpenBridgeModeler\Configuration 
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Project ORD WorkSets 

Storing WorkSpaces and WorkSets on ProjectWise is referred to as Managed WorkSpaces. 

WorkSpaces and WorkSets will be created automatically by NCDOT when the project is initially 

created on ProjectWise. The user will not need to create either (though some manual file 

renaming may be necessary). 

Storing WorkSpaces and WorkSets outside of ProjectWise is referred to as Nonmanaged 

Workspaces.  While using Nonmanaged WorkSpaces, the WorkSets will be created and stored 

outside of ProjectWise on the local C:\ Drive as described below. 

A WorkSet is a collection of files that defines the project and plan-set parameters and uses the 
resources and standards of a WorkSpace.  A WorkSet is the “child” of a WorkSpace. For each 
WorkSet, there is a corresponding STIP#.dgnws and STIP#.cfg configuration files that specify 
locations for the various files that comprise the WorkSet resources and designs. In some cases, 
it is desirable to override or augment the standards supplied at the Organization and 
WorkSpace level with standards that are appropriate for a particular project. That can be 
accomplished in WorkSet Configuration Files. 
 
WorkSets are named using the STIP number of your project. For example, name your WorkSet 
R-2635C with a CAPITAL first and LAST LETTER and a dash between the first letter and the 
numbers.  Note that this is different than the old Design File Generator instructions that 
eliminated the dash.  It is however consistent with the STIP name in NCDOT’s STIP and SAP.  
 
Examples 
R-2635C.cfg points to where the project CADD files and Design Standards are stored 
R-2635C.dgnws contains the sheet index for the project 
 
WorkSets can also be stored in customized locations according to your needs.  Since project 
information such as the Plan Sheet Index is stored in the WorkSet, it is important that all users 
working on a project have access to the most recent version of the WorkSet when entering 
project files.  This should be considered when choosing a place to store the WorkSet.  If it is 
chosen to be stored locally, then consider how others working on the project will be able to 
access the most recent version of the WorkSet files.  If it is necessary to be stored on a server 
for everyone to access, use the L0 Load Value in the NCDOT_WorkSets.inp file described below 
and follow the link below to get instructions posted on NCDOT’s CADD Services website. 

 
NCDOT CADD Services 

 AWAITING WEBSITE TO BE REVISED BY CADD SERVICES TO ADD SERVER 
WORKSPACE/WORKSET INSTRUCTIONS 

 

https://connect.ncdot.gov/resources/CADD/Pages/default.aspx
https://connect.ncdot.gov/resources/CADD/Pages/default.aspx
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The NCDOT_WorkSets.inp file on your desktop contains a variable that can be edited to path to 
where you choose to locate your WorkSets.  Edit these three values with the proper values 
before you use the NCDOT icon to launch your ORD design files. 
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MY_WORKSET_LOCATION = (Folder Location) 
 
If the user sets the Load Value option described below to be L0, set this Folder Location value 
to be the folder where you want your project’s WorkSets stored. 
 
This can be a common folder containing WorkSet files for all projects such as R:\Projects or a 
folder under each project such as R:\Workset that contains the WorkSet files for only that 
project.  Storing WorkSets under each project requires a means such as NCDOT’s Mapdrive to 
map the R:\ Drive to each individual project to access that project’s WorkSet.  
 
 
NCDOT_USE_LOCAL_WORKSETS = (Load Value) 
 
Load Value Options 
L0 = R:\Projects 

• Can be any drive letter or folder name and is commonly mapped to a server location 
 
L1 = C:\Projects\NCDOT 

• Default WorkSet location that was loaded with the NAME?.zip file and contains 
example WorkSets 

 
L2 = C:\MICROSTATION_CONNECT_WORKSPACE\Configuration\Organization- 

Civil\Disciplines\NCDOT_(Unit)\WorkSets 

• NCDOT Unit Training and Administrative WorkSets 
 
L3 = \\Configuration\WorkSpaces\DOT-US North Carolina\WorkSets  

• Bentley default location 
 
 

NCDOT_UNIT_TRAINING_WORKSETS = (Unit Name) 
 

If the user sets the Load Value option described above to be L2, set this Unit Name value to be 
one of the Unit Name values listed in the NCDOT_WorkSets.inp file to access that unit’s 
training. 
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Create WorkSet Files 

Storing WorkSpaces and WorkSets on ProjectWise is referred to as Managed WorkSpaces. 

WorkSpaces and WorkSets will be created automatically by NCDOT when the project is initially 

created on ProjectWise. The user will not need to create either. 

Storing WorkSpaces and WorkSets outside of ProjectWise is referred to as Nonmanaged 

Workspaces.  While using Nonmanaged WorkSpaces, the WorkSets will be created and stored 

outside of ProjectWise on the local C:\ Drive as described below. 

A WorkSet must be created before Design Files can be created since the Design Files will be 

calling the WorkSpace to get NCDOT standards and the WorkSet to get project standards when 

you open them. 

 
Video 1-3 Creating WorkSet Files outside of ProjectWise 

HTTP LINK PLACEHOLDER 
REDO THIS VIDEO WITH NEW WORKSET OR STANDARDS SUBDIRECTORIES 

 

1. Creating a WorkSet  
A. Locate the NCDOT Roadway ORD Icon on your desktop that was loaded with the NCDOT 

WorkSpaces and manually copied to your desktop from the following folder earlier. 
 

C:\MICROSTATION_CONNECT_WORKSPACE\Configuration\WorkSpaces\DOT-US North 
Carolina\Desk 

 
 

 

 

B. To open a NCDOT ORD design file properly, ensure that your NCDOT_WorkSets.inp file 
is configured to write the C:\Projects\NCDOT folder by setting the variable in the 
NCDOT_Worksets.inp file on your desktop as show below:   
 

file:///C:/Users/dsarvis/OneDrive%20-%20Stantec/Documents/Microstation_Mobile_Files/Projects/ORD%20Pilot%20Phase%20II/Video%201-3%20Creating%20WorkSet%20Files%20outside%20of%20ProjectWise.mp4
file:///C:/MICROSTATION_CONNECT_WORKSPACE/Configuration/WorkSpaces/DOT-US%20North%20Carolina/Desk
file:///C:/MICROSTATION_CONNECT_WORKSPACE/Configuration/WorkSpaces/DOT-US%20North%20Carolina/Desk
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• NCDOT_USE_LOCAL_WORKSETS = L1 
 

C. Choose the MyChoice NCDOT_10 icon to launch ORD  
 

 
 

D. The following dialogue will appear.  
 

 
 

E. Choose the down arrow next to No WorkSpace and choose the DOT-US North Carolina 
Workspace. 

 

 
 

F. Once the WorkSpace is chosen, the B-0000 WorkSet will appear.  Choose the down 
arrow next to B-0000 and choose Create WorkSet to create a new WorkSet to have 
available to assign to your new file. 
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A. Enter a name and description for your WorkSet.  WorkSets are named using the STIP 
number of your project. For example, name your WorkSet R-2635C with a CAPITAL first 
and LAST LETTER and a dash between the first letter and the numbers.  Choose the 
down arrow next to the template box and choose the B-0000 project provided when the 
WorkSpaces were loaded to use and as a template to create your WorkSet 
subdirectories with.  CHECK THE CREATE FOLDERS ONLY BOX or the sample project’s 
subdirectories AND FILES will be copied when creating your WorkSet.  Choose OK to 
create the new WorkSet 

 

 



 

Module 1 – File Management 
 

 
 

Page | 28  
 
 

 

J. A folder with the project name R-2635C and the two main WorkSet files R-2635C.cfg 
and R-2635C.dgnws  
 
OAK SHOULDN’T THESE TWO FILES BE CREATED UNDER THE STANDARDS FOLDER 
UNDER ROADWAY? 
 
described earlier will be created in the C:\Projects\NCDOT folder.  The R-2635C folder 
contains the default NCDOT ORD folder structure.  
 
CHANGE THE NEXT SCREENSHOT IF OAK MOVES THESE FILES TO STANDARDS  
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ORD Folder Naming Convention 

For proper organization and consistency, an ORD folder structure has been developed and all 
new projects will be stored on ProjectWise with the following subdirectories.  
 
Original editions of files transmitted between shareholders of a project should be stored on a 
local server and only the edited version of the transmitted design file should be stored on 
ProjectWise. 
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Archiving Files at Project Stages 

Project plan sets will be assembled and submitted at stages throughout the life of the project.  
This will be accomplished by producing a set of PDF plans and storing them in the PDF folder 
under the appropriate stage of the project.  Archiving of the project design files used to 
produce the plans at a particular stage will be accomplished by utilizing the Version and 
Document Set capabilities in ProjectWise explorer. 

 

 
Video 1-4 Archiving Files at Project Stages 

HTTP LINK PLACEHOLDER 
 

1. Archiving Files at Project Stages 
A. Launch ProjectWise Explorer using the Icon. 

 

 
 

B. Navigate to the folder that contains the project files that you want to archive at a 
specific project stage. Choose the files that you want to assign a Version designation to 
and note the Version number or letter if one exists. 

 

file:///C:/Users/dsarvis/Downloads/4.%20Create%20WorkSet%20in%20ProjectStore%20R%20Drive.mp4
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C. Right click over the files and choose New → Version 

 
 

D. Type in a Version string format to assign to each selected file.  
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E. Each selected file is copied and a new Version name is assigned to the copied files. 

 
 

F. To view all versions of the files, choose Tools → Options 
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G. Choose Settings → Show all Versions 
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H. Tag the Version column to sort by Version names and choose the files to add to the 
Document Set. 
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I. Right click over the files and choose Set → New 
 

 
 

J. Type in a Name and Description for the Document Set 
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K. Select all files and check the Lock To Version box to ensure that this Version of the files 
is called when the document set is opened in the future.  

 

 
 

L. Note the Document Set added to the folder which will call the assigned Version of the 
files thereby providing an archived version of the project at the specified stage of the 
project.  
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M. Double Click the Document Set to open the Document Set dialog box where additional 
files can be drug to include in the Document Set. 
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ORD Design File Naming Conventions 

ORD Design File Naming Convention will follow the same naming convention format that 

NCDOT has used for many years with two exceptions. 

1. There will be a dash between the first letter and the STIP number.  

2. The file name will be in ALL CAPITAL LETTERS except for the .dgn extension.  

The following format applies for all new ORD design files: 

(STIP NUMBER)_(UNIT ABBREVIATION)_(FILE TYPE)_(DESCRIPTION).dgn  

Example R-2635C_RDY_DSN_ALT1.dgn  

(STIP NUMBER) is the Strategic Transportation Improvement Program assigned number 

 Example R-2635C 

(UNIT ABBREVIATION) is the assigned NCDOT Unit Code.  Choose the link below to get a 

complete listing of unit codes.  

NCDOT CADD Services AWAITING REVISED UNIT CODES TO BE ADDED TO THE WEBSITE 

 Examples 

  RDY – Roadway Design LS – Location Surveys 

  HYD – Hydraulics Design PH - Photogrammetry 

Note: Assign this ALL CAPS unit abbreviation as the logical name for the reference file when 

this file is attached to another file.  This allows pentables to call the reference file by unique 

logical name and print it with proper shading, color, priority, or transparency.  

(FILE TYPE) is the two or three letter code describing contents of file  

 Examples 

ALG - Alignments  DSN – Design   

CMD – Corridor Modeling SUP – Superelevation 

(DESCRIPTION) (Optional) content description of the file 

 Examples 

  1 – Alternative of a DSN file 

  211225 - date format is year, month, day (December 25,2021) 

https://connect.ncdot.gov/resources/CADD/Pages/default.aspx
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ORD File List with File Contents and References 

The following is an ORD Folder Listing showing the common design files that belong under 
them, the design elements that are in them, and the design files that are commonly referenced 
to those design files.  Following this standard convention will assist others using the files to 
locate and use the data they need to complete their portion of the project.  Consistency is the 
key for efficient communication between users.  
 
R-2635C 

├───Congestion Management 

├───Construction Revisions? JASON WHAT GOES HERE? 

├───Drainage 

│       R-2635C_HYD_DRN.dgn 

│       R-2635C_HYD_EC.dgn 

│        

├───Final Survey 

│       R-2635C_LS_DTM.dgn 

│       R-2635C_LS_TIN.tin 

│       R-2635C_NCDOT_ETM.dgn 

│       R-2635C_NCDOT_FS.dgn 

│       R-2635C_NCDOT_ROW.dgn 

│        

├───Geoenvironmental 

├───Geotechnical 

├───Human Environment 

├───Hydraulics 

├───Intelligent Transportation Systems 

├───Lighting Electrical 

├───Location Surveys 

├───Natural Environment 

│       R-2635C_NEU_WET.dgn 

│        

├───Photogrammetry 

│   └───Aerial 

│           R-2635C_PH.sdw 

│           R-2635C_PH.sid 

├───Rail 

├───Roadside Environmental 

├───Roadway 

│   ├───Alignment 

│   │       R-2635C_RDY_ALG.dgn 

│   │       R-2635C_RDY_L.dgn 

│   │       R-2635C_RDY_Y.dgn 

│   │       R-2635C_RDY_Y1.dgn 

│   │        

│   ├───Alternatives 

│   │       R-2635C_RDY_DSN_ALT1.dgn 

│   │       R-2635C_RDY_EST_CON.dgn 

│   │       R-2635C_RDY_EST_ROW.dgn 

│   │       R-2635C_RDY_HIS.dgn 
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│   │       R-2635C_RDY_PHM_1.dgn 

│   │        

│   ├───Design 

│   │       R-2635C_RDY_AER.dgn 

│   │       R-2635C_RDY_ATN.dgn 

│   │       R-2635C_RDY_CMD.dgn 

│   │       R-2635C_RDY_DSN.dgn 

│   │       R-2635C_RDY_EAR.dgn 

│   │       R-2635C_RDY_EOP.dgn 

│   │       R-2635C_RDY_EST.dgn 

│   │       R-2635C_RDY_SS.dgn 

│   │       R-2635C_RDY_SUP.dgn 

│   │       R-2635C_RDY_SUR.dgn 

│   │        

│   ├───Documentation 

│   ├───PDF 

│   │   ├───R-2635C_STAGE 1_PROJECT_INITIATION 

│   │   │       R-2635C_RDY_PLS.pdf 

│   │   │       R-2635C_RDY_PRS.pdf 

│   │   │       R-2635C_RDY_XSS_L.pdf 

│   │   │       R-2635C_RDY_XSS_Y.pdf 

│   │   │       R-2635C_RDY_XSS_Y1.pdf 

│   │   │        

│   │   ├───R-2635C_STAGE 2_ALINGMENT_DEFINED 

│   │   ├───R-2635C_STAGE 3_PLAN-IN-HAND 

│   │   ├───R-2635C_STAGE 4_PSE 

│   │   ├───R-2635C_STAGE 5_LETTING 

│   │   └───R-2635C_STAGE 5_POST-LETTING 

│   ├───Sheets 

│   │       R-2635C_RDY_CTY.dgn 

│   │       R-2635C_RDY_DTL.dgn 

│   │       R-2635C_RDY_DTL_2B.dgn 

│   │       R-2635C_RDY_PPL.dgn 

│   │       R-2635C_RDY_PPL_PLS_004_THRU_014.dgn 

│   │       R-2635C_RDY_PPL_PRS_015_THRU_020.dgn 

│   │       R-2635C_RDY_SUM_3B.dgn 

│   │       R-2635C_RDY_TSH.dgn 

│   │       R-2635C_RDY_TYP.dgn 

│   │       R-2635C_RDY_XPL.dgn 

│   │       R-2635C_RDY_XSS_L.dgn 

│   │        

│   └───Standards 

│       │   R-2635C_RDY.cfg 

│       │   R-2635C_RDY.dgnrl 

│       │    

│       ├───Cell 

│       │       R-2635C_RDY.cel 

│       │        

│       ├───Data 

│       ├───Dgnlib 

│       │       R-2635C_RDY.pltcfg 

│       │       R-2635C_RDY.pset 
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│       │       R-2635C_RDY.tbl 

│       │       R-2635C_RDY_PRINT.dgnlib 

│       │        

│       ├───Macros 

│       ├───Seed 

│       ├───Sheet Borders 

│       │       R-2635C_RDY_LOGO.dgn 

│       │       R-2635C_RDY_SEAL.dgn 

│       │        

│       ├───Superelevation 

│       ├───Symbols 

│       └───Template Library 

│               R-2635C_RDY.itl 

│                

├───Signals 

│       R-2635C_SIG_POL.dgn 

│        

├───Signing and Delineation 

│       R-2635C_SGN_DSN.dgn 

│        

├───Structures 

│       R-2635C_SMU_S1.dgn 

│        

├───Utilities 

│       R-2635C_UC_POW.dgn 

│       R-2635C_UC_SEW.dgn 

│       R-2635C_UC_WAT.dgn 

│        

├───Work Zone Traffic Control 

└───Workset 

    ├───Cell 

    ├───Data 

    ├───Dgnlib 

    ├───Macros 

    ├───Seed 

    ├───Sheet Borders 

    │       R-2635C_RDY_BDR.dgn 

    ├───Superelevation 

    ├───Symbols 

    └───Template Library 

 
  



 

Module 1 – File Management 
 

 
 

Page | 42  
 
 

\Alignment 
This folder contains the design files that have the proposed horizontal and vertical alignments 
(HAL and VAL) in them for use with ORD modeling.  Each horizontal and corresponding vertical 
alignment is to be located in its own separate ALG design file.  Each of these files are then 
referenced to a master ALG alignment file to make referencing all of the individual alignments 
to another file easier. When a design procedure requires the project’s alignment information 
such as cutting plan, profile and XS sheets,  the user can reference just the master ALG with a 
Live Nested Depth of 1.  This will automatically reference all the individual alignments ALG 
file(s) that were attached to the master ALG design file. 
 
Referencing the Existing Terrain Model (ETM) to each alignment file is required.  Making the 
ETM file Active is necessary to display the existing ground profile.  This procedure will be 
explained in future training Modules. 
 

 
 
All horizontal and vertical alignments for smaller projects such as bridge replacement projects 
can be stored in the master ALG file for ease of use. 
 
For projects whose design began in GEOPAK SS2, the GPK file should be placed in the Alignment 
folder to use when converting alignments to a format that is compatible with ORD.  Beware 
that conversion can create slight mathematical differences in the alignment and once 
converted to ALG, the GPK file should not be used again for obtaining alignment information. 

 
File Types 

• ALG - Horizontal and Vertical Alignments 

• ETM - Existing ground profile\contours 
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Example Files 
• R-2635C_RDY_ALG.dgn    (master ALG file) 

Contains 
 No Elements 

Files Referenced 
 R-2635C_RDY_ALG_L.dgn    (all individual HAL ALG files) 
 
• R-2635C_RDY_ALG_L.dgn   (individual alignment ALG file) 

Contains 
 HAL and VAL with no annotation  

Files Referenced 
 R-2635C_RDY_ALT_1.dgn  (preferred alternative from Alternatives) 
 R-2635C_RDY_HIS.dgn  (historic properties from Alternatives) 
 R-2635C_RDY_HAZ.dgn  (hazardous sites from Alternatives) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_AER.dgn  (aerial photography) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_LS or PH or NCDOT_ETM.DGN (existing ground profile\contours) 
 AWAITING FAITH/EMORY TO CONFRIM NAMING  
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\Alternatives 
This folder contains all the design files such as horizontal and vertical alignments, corridor 
models, documents, roll plots, and hearing maps used to evaluate project alternatives. 
 
File Types DISCUSS WITH OAK 

• ALT   Alternatives 

• CHM (or CMP?)  Corridor Hearing Map Sheet SOLIDIFY NAME? 

• CHS (or CMS?)  Corridor Hearing Map Shapes SOLIDIFY NAME? 

• COR  Corridor Map FROM PW CHOICES, SOLIDIFY NAME COR?, CHM?, CMP? 

• EST   Estimate Shapes 

• HAZ   Hazardous Sites 

• HIS   Historic Properties 

• IMP  Wetland and Stream Impacts 

• PHM (or PMP?)  Public Hearing Map SOLIDIFY NAME? 

• PHS (or PMS?)  Public Hearing Map Shapes SOLIDIFY NAME? 

• STR   Structures 
 

 
Example Files 
• R-2635C_RDY_DSN_ALT1.dgn 
• R-2635C_RDY_DSN_ALT2A.dgn 
• R-2635C_RDY_CHM_1.dgn 
• R-2635C_RDY_CHS_2.dgn 
• R-2635C_RDY_HIS.dgn 
• R-2635C_RDY_IMP.dgn 
• R-2635C_RDY_PHM_1.dgn 
• R-2635C_RDY_PMS_2.dgn  
• R-2635C_RDY_STR.dgn 
 
• R-2635C_RDY_EST_ROW.dgn  

Contains 
 Shapes and area labels used for producing right-of-way estimates 

Files Referenced 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography) 
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
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 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1) 
 R-2635C_RDY_SUP.dgn  (superelevation) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
 
• R-2635C_RDY_EST_CON.dgn  

Contains 
 Shapes used for producing construction estimates  

Files Referenced 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography) 
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1) 
 R-2635C_RDY_SUP.dgn  (superelevation) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
 
 
 
STRONGLY SUGGEST INCLUDING THE FOLLOWING SUBDIRECTORIES UNDER ALTERNATIVES TO 
BE ABLE TO GROUP FUNCTIONAL AND PRELIMNARY DESIGN FILES THE SAME AS WE GROUP 
FINAL DESIGN FILES.  SINCE THESE FOLDERS HAVE BEEN DETERMINED TO BE NEEDED UNDER 
DESIGN FOR FINAL ROADWAY DESIGN PURPOSES, THEN THEY’RE ALSO NEEDED UNDER 
ALTERNATIVES FOR ALTERNATIVES ROADWAY DESIGN PURPOSES 
 
\Alternative 1   

\Alignments 
\Design 
\Documentation 
\PDF 
\Sheets 

 
\Alternative 2   

\Alignments 
\Design 
\Documentation 
\PDF 
\Sheets 
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\Design 

This folder contains all the 2D and 3D design files as well as non-design files necessary to 
produce a corridor model. 
 
There is an important change from previous methods of 3D modeling when using ORD.  The 
designer will now utilize the template to draw a majority of the design file elements such as 
edge of pavements and curbs into the 2D model of the CMD file and NOT into the DSN file. 
The DSN file will mainly contain elements not used for producing the corridor model such as 
annotations, labels, dimensions, lane arrows, super labels, paint striping, and hatching but 
can be used to draw temporary construction class elements such as a right turn bay which the 
template will read when reprocessed and draw Primary Class elements of the turn bay into 
the 2D CMD model. 
 
 
File Types (extensions) 

• AER - Aerial ADD TO PW LIST 
 (.JPG) - Aerial (raster files from Google Earth to update aerial) 

  (.DWG) - Site Plans   
  (.PDF) - Site Plans (used to update aerial)   

• ATN - AutoTurn 

• CMD - Corridor Modeling 

• DSN – Design 

• EAR – Earthwork ADD TO PW LIST 

• EOP – Edge of Pavement   

• EST – Estimate Shapes Design File 

• GGC – Geopak Graphical Criteria DELETE FROM PW LIST 

• (.KMZ) - Google Earth (exported DSN or CMD 2D model) 

• PAT – Pattern Lines DELETE FROM PW LIST 

• SHP – Geopak Shape DELETE FROM PW LIST 

• SPD – Shear Point Diagram (if requested) 

• STR_REC – Structure Recommendation DELETE FROM PW LIST 

• SIGHT - Sight Distance Design Elements ADD TO PW LIST 

• SS - Slope Stakes OAK SAID ROADWAY ADMINISTRATION NEEDS TO ADD NOTE IN PLANS 
THAT THESE COME FROM CMD.  OAK HOW TO GET C’s and F’s INTO THE FILE? 

• SUP - Superelevation 

• SUR - Survey Request RENAMED SVY_REQ FROM PW LIST CHANGE NAME IN PW LIST  
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PROJECTWISE PULLDOWN 
ADD NEW FILE TYPES FROM ABOVE 
DELETE OLD FILE TYPES FROM ABOVE 
PUT PW LIST IN ALPHABETICAL ORDER 
(DELETE THIS LIST FROM DOCUMENTATION) 
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DELETE WHEN FINISHED WITH DOCUMENTATION 
MASTER REFERENCE LIST 
  R-2635C_EC_DSN.dgn  (erosion control from Drainage) 
  R-2635C_HYD_DRN.dgn (hydraulics from Drainage) 
  R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
  R-2635C_NCDOT_FS.dgn (final surveys from Final Survey) 
  R-2635C_NEU_WEX(T).dgn (wetlands from NEU) 
  R-2635C_RDY_ALG.dgn (alignments from Alignments) 
  R-2635C_RDY_AER.dgn (aerial photography) 
  R-2635C_RDY_CMD.dgn (master CMD file’s 2D & 3D models) 
  R-2635C_RDY_DSN.DGN  

(annotations, labels, dimensions, hatching, construction class design elements) 
  R-2635C_RDY_HIS.dgn (historic properties from Alternatives) 
  R-2635C_RDY_HAZ.dgn (hazardous sites from Alternatives) 
  R-2635C_RDY_PPL.dgn (plan sheet layout) 
  R-2635C_RDY_ROW.dgn (right of way from Final Survey) 
  R-2635C_RDY_SIGHT.dgn (sight distance)  
  R-2635C_RDY_SIGNS.dgn (business’ relocated signs) 
  R-2635C_RDY_SS.dgn  (slope stakes from CMD Nested 1) 
  R-2635C_RDY_SUP.dgn (superelevation) 
  R-2635C_SMU_S1.dgn (bridge general drawings from Structures) 
  R-2635C_SIG_POL.dgn (signal poles from Signals) 
  R-2635C_UT_POW.dgn (power from Utilities) 
  R-2635C_UT_SEW.dgn (sewer from Utilities) 
  R-2635C_UT_WAT.dgn (water from Utilities) 
  “VARIOUS NAMES”.dwg (site plans adjacent to project) 
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Example Files 
• R-2635C_RDY_AER.dgn 

Contains 
 No Design Elements  

Files Referenced 
 R-2635C.sid    (corridor from Photogrammetry) 
 R-2635C.sid (tiles of additional coverage for Hydraulics and Noise from Web) 
 R-2635C_RDY_AER_“site name”.jpg  (updates to aerial from Google Earth) 
 R-2635C_RDY_AER_“site name”.pdf  (pdf’s of site plans unavailable as DWG) 
 
• R-2635C_RDY_ATN.dgn 

Contains 
 Turning envelopes for design vehicles  

Files Referenced 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn  (roadway design elements are now stored in CMD) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 
• R-2635C_RDY_AER_“site name”.jpg 

 Contains 
 Aerial images of updated areas extracted from Google Earth  

 Files Referenced 
 N/A 
 
• R-2635C_RDY_AER_“site name”.pdf 

 Contains 
 PDF’s of site plans unavailable as DWG  

 Files Referenced 
 N/A 
 
• R-2635C_RDY_AER_“site name”.DWG 

 Contains 
 AutoCad elements  

 Files Referenced 
 N/A 
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• R-2635C_RDY_CMD.dgn   (master CMD file) 
 Contains   
 No Design Elements 
 Files Referenced 
 R-2635C_RDY_CMD_L.dgn   (all individual alignments CMD files) 
 
• R-2635C_RDY_CMD_L.dgn   (individual alignment CMD file < 1 mile long) 
 One CMD file per short alignment 
 
 OR 
 
• R-2635C_RDY_CMD_L_SECT1.dgn (section 1 of individual alignment > 1 mile)  
• R-2635C_RDY_CMD_L_SECT2.dgn (section 2 of individual alignment > 1 mile)  
 Multiple CMD files containing a Section of one long alignment 

A corridor along an alignment that is greater than one mile long should be divided into 
one-mile segments to optimize model processing speed.   The corridor should be 
divided on a tangent but not be broken in an intersection or on a vertical curve.  The 
alignment should NOT be divided, only the corridor along it.    

 
• R-2635C_RDY_CMD_L  AND Y6.dgn (detailed model of intersection)  
 One CMD file for each Detailed Modeled intersection  

The user should split the corridor models at intersections as shown below. 
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• R-2635C_RDY_CMD_L  AND Y14.dgn (interchange)  
 One CMD file for each interchange  

The user may also elect to separate the CMD file into areas that contain multiple 
alignments that are related to each other such as an interchange. 

 

 
 

 Contains   
 Roadway Design elements in 2D model generated by the templates 
 Roadway Design corridor model in 3D model generated by the templates  
 Files Referenced 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_ATN.dgn  (AutoTurn envelopes) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD_Y.dgn  (adjacent alignment’s CMD file’s 2D & 3D models) 
 R-2635C_RDY_DSN.DGN   

(annotations, labels, dimensions, hatching, construction class design elements) 
 R-2635C_RDY_HIS.dgn  (historic properties from Alternatives) 
 R-2635C_RDY_HAZ.dgn  (hazardous sites from Alternatives) 
 R-2635C_RDY_PPL.dgn  (plan sheet layout) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1)  
 R-2635C_RDY_SUP.dgn  (superelevation) 
 R-2635C_SIG_POL.dgn  (signal poles from Signals) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
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 R-2635C_UT_POW.dgn  (power from Utilities) 
 R-2635C_UT_SEW.dgn  (sewer from Utilities) 
 R-2635C_UT_WAT.dgn  (water from Utilities)  
 “VARIOUS NAMES”.dwg  (site plans adjacent to project) 
 
• R-2635C_RDY_DSN.dgn  
 Contains 

Annotations, Labels, Dimensions, Hatching 
 Construction class design elements for the template to target and redraw 

 
 Files Referenced 
 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_PPL.dgn  (plan sheet layout) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1)    
 R-2635C_RDY_SUP.dgn  (superelevation) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
 
• R-2635C_RDY_EAR.dgn 
 Contains 
 Named Boundaries 
 3D mesh elements representing cut and fill 
 Files Referenced 
 R-2635C_RDY_ALG.dgn   (alignments from Alignments) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 
• R-2635C_RDY_EST_CON.dgn  
 Contains 
 Shapes used for producing construction estimates  
 Files Referenced 
 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
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 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_DSN.DGN   

(annotations, labels, dimensions, hatching, construction class design elements) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1)  
 R-2635C_RDY_SUP.dgn  (superelevation) 
  R-2635C_SMU_S1.dgn (bridge general drawings from Structures) 
 
• R-2635C.kmz 
 Contains 
 Rasterized images of the design file elements in Google Earth format  
 Files Referenced 
 N/A 
 
• R-2635C_RDY_SIGHT.dgn 
 Contains 
 Design elements of plan view sight distance calculations 
 Files Referenced 
 Some design files shown referenced are not available for the first evaluation of sight 

distances but need to be referenced to recheck sight distances once these additional 
designs are completed.   

 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1) 
 R-2635C_RDY_SUP.dgn  (superelevation) 
 R-2635C_SIG_POL.dgn  (signal poles from Signals) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
 R-2635C_UT_POW.dgn  (power from Utilities) 
 R-2635C_UT_SEW.dgn  (sewer from Utilities) 
 R-2635C_UT_WAT.dgn  (water from Utilities) 
 “VARIOUS NAMES”.dwg  (site plans adjacent to project) 
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• R-2635C_RDY_SIGNS.dgn 
 Contains 
 Businesses relocated sign locations 
 Files Referenced 

Some design files shown referenced are not available for the first evaluation of sight 
distances but need to be referenced to recheck sight distances once these additional 
designs are completed.   

 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1)  
 R-2635C_RDY_SUP.dgn  (superelevation) 
 R-2635C_SIG_POL.dgn  (signal poles from Signals) 
 R-2635C_RDY_PPL.dgn  (plan sheet layout) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
 R-2635C_UT_POW.dgn  (power from Utilities) 
 R-2635C_UT_SEW.dgn  (sewer from Utilities) 
 R-2635C_UT_WAT.dgn  (water from Utilities) 
 “VARIOUS NAMES”.dwg  (site plans adjacent to project) 
 
• R-2635C_RDY_SS.dgn 

Contains 
 Minimal Supplemental Slope Stakes drawn in for clarity 
 C’s and F’s indicating Cut and Fill placed by…….. 
 OAK HOW TO DRAW IN C’s and F’s? 
  End point custom linestyle 
  New place civil label from Bentley for Release 10.10 
  Old place label commands 
 Files Referenced 

Some design files shown referenced are not available for the first run of the slope stakes 
but need to be referenced to check slope encroachment on those additional designs and 
for labeling conflicts.   

 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
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 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn 

(master CMD file’s 2D & 3D models referenced with nested depth of 1 to see slope 
stakes of individual alignment models) 

 R-2635C_RDY_DSN.DGN   
(annotations, labels, dimensions, hatching, construction class design elements) 

 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SUP.dgn  (superelevation) 
 R-2635C_RDY_PPL.dgn  (plan sheet layout) 
 R-2635C_SIG_POL.dgn  (signal poles from Signals) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
 R-2635C_UT_POW.dgn  (power from Utilities) 
 R-2635C_UT_SEW.dgn  (sewer from Utilities) 
 R-2635C_UT_WAT.dgn  (water from Utilities) 
 “VARIOUS NAMES”.dwg  (site plans adjacent to project) 
 
• R-2635C_RDY_SUP.dgn 
 Contains 
 Design elements showing superelevation sections 
 Graphical, editable shapes with slopes and stations 
 Files Referenced 

Some design files shown referenced are not available for the first design of 
superelevation but need to be referenced to revise the superelevation once these 
designs are completed.   

 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography) 
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
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 R-2635C_RDY_PPL.dgn  (plan sheet layout) 
 R-2635C_SIG_POL.dgn  (signal poles from Signals) 
 R-2635C_UT_POW.dgn  (power from Utilities) 
 R-2635C_UT_SEW.dgn  (sewer from Utilities) 
 R-2635C_UT_WAT.dgn  (water from Utilities) 
 “VARIOUS NAMES”.dwg  (site plans adjacent to project) 
 
• R-2635C_RDY_SUR.dgn 
 Contains 
 Design elements showing plan view areas needed for survey requests 
 Clarification notes for survey request 
 Files Referenced 
 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1)  
 R-2635C_RDY_SUP.dgn  (superelevation) 
 R-2635C_SIG_POL.dgn  (signal poles from Signals) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
 R-2635C_UT_POW.dgn  (power from Utilities) 
 R-2635C_UT_SEW.dgn  (sewer from Utilities) 
 R-2635C_UT_WAT.dgn  (water from Utilities) 
 “VARIOUS NAMES”.dwg  (site plans adjacent to project) 
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\Documentation 
This folder contains the Roadway Design project history, documentation, and calculations in 
non-CADD formats.  
THE FUNDAMENTAL QUESTION IS WHERE TO STORE SOMETHING LIKE FINAL PAVEMENT 
DESIGN, REQUESTED BY ROADWAY AND DESIGNED BY PAVEMENT DESIGN.  I PROPOSE THAT 
THE ORIGINAL STAYS IN A DESIGNATED FOLDER UNDER PAVEMENT DESIGN AND WE PLACE A 
LINK TO THAT DOCUMENT WITHIN PROJECTWISE IN OUR DOCUMENTATION FOLDER RATHER 
THAN COPYING IT.  THAT WAY THE OWNER KEEPS IT AND WE JUST “REFERENCE” IT JUST LIKE 
WE REFERENCE THE DRN FILE IN THE DRAINAGE FOLDER.  
Notice to proceed (NTP) letter 
Note to file (NTF) .doc 
Design Assumptions 
Design Exceptions 
Design Checklists 
Workshop Materials (.pdf, .doc, .jpg) 
DOES PDF’S OF THE MAPS GO HERE OR IN ALTERNATIVES?  PREFER TO KEEP IN ALTERNATIVES 
AND PLACE A LINK TO THEM HERE 
Pictures 
  THIS COULD GET MESSY UNLESS A METADATA FILTERING SYSTEM SET UP, I HAVE 
ALMOST 400 PHOTOS ON MY LATEST PROJECT AND ITS NOT COMPLETE YET 
Correspondence letters 
Advanced acquisition letter 
Cost estimates at various phases of design 

ROW AND UTILITIES ESTIMATES OR ARE THEY STORED IN RIGHT OF WAY (BTW NO R/W 
FOLDER IN PROJECTWISE) OR UTILITITES AND A LINK ADDED HERE TO ACCESS THEM? 
Cost justification letter if applicable 
Bridge vs. Culvert cost estimates 
Field inspection checklist, letters, and notes 
Survey and additional survey requests 
Meeting minutes and notes 
Encroachment agreement letters 
Vertical clearance calculations 
Gore area control point calculations 
Superelevation calculations 
Wetland / Stream impact calculations IN ALTERNATIVES’ DOCUMENTS FOLDER AND A LINK 
HERE? 
Pavement Design Requests 
Field Visit Notes 
Alignment name spreadsheet 
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Row revisions list 
Special Details 
Sight distance calculations 
Signs relocation inventory 
Parcel Index 
MORE? 
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\PDF 
This folder contains Roadway project plan sets in a PDF format at various stages of design.  
These PDFs are used for the submittals, review and markups, approval, and distribution of 
these plan sets. 
 
From Bob’s Email 
“Created (where?) and pushed to sharepoint (when?)  (how?) 

1) The files can be versioned after the pdf are created. The files and PDF can be listed in a 
document set for publishing to SharePoint. Also, Roadway has the attribute of Phase 
showing the work progress.” 

BOB HOW TO ACCESS? EMAILED BOB AND WAITING FOR RESPONSE 
BOB NEED TO CHANGE PHASES TO MATCH IPD 

 
 

FOLDERS OR NAME THE PDF MILESTONE PLANS THE STAGE NAME? 

\STAGE 1 Project Initiation 

\STAGE 2 Alignment Defined 

\STAGE 3 Plan-In-Hand 

\STAGE 4 PSE 

MUST HAVE THESE FOLDERS OR ANOTHER WAY TO DO IT WITH METADATA TO 

ASSEMBLE FINAL PDF PLANS FOR TURN-IN 

\100 Roadway Plans 

\200 Transportation Management Plans 
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 \remaining subdirectories required at final plans turn-in 

\STAGE 5 Letting and Post Letting 

 
File Type 
FROM NCDOT’S NEWEST LIST 

• PLS – Title, Symbology, Typicals, Summaries, Details, Plans Sheets 

• PRS – Profile Sheets 

• XSS – Cross Section Sheets 
 

Example Files 
FROM NCDOT’S NEWEST LIST 

• R-2635C_RDY_PLS.pdf 

• R-2635C_RDY_PRS.pdf 

• R-2635C_RDY_XSS.pdf   (Small projects with few cross sections) 

• R-2635C_RDY_XSS_L.pdf   (Larger projects split by alignment) 

• R-2635C_RDY_XSS_RAMPA.pdf 

• R-2635C_RDY_XSS_Y.pdf 

• R-2635C_RDY_XSS_Y1.pdf 
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\Sheets 
This folder contains design files that contain the plan, profile, cross section, and other 
miscellaneous sheets used to communicate the design of the project to others.  Sheets for 
plans, profiles, and cross sections are semi-automatically produced using the sheet layout 
programs within ORD.  The rest of the plan sheets such as title, typical, details, summaries are 
produced as in the past with design elements being drawn into the files and a border 
referenced in from a R-2635C_NCDOT_BDR.dgn file.  This file contains all of the project borders 
needed for the project in individual Models that the user manually references to a design file 
for producing sheets other than the sheets semi-automatically produced for plan, profile, and 
cross section layout.  Models and the Standard Sheet Borders in the file are listed below: 

 
“Title Sheet” Model (Title Sheet Border)  
“Index of Sheets” Model    (Index of Sheets / General Notes / Standard Drawings Border) 
“Conventional Symbols Sheet” Model     (Conventional Symbols Sheet) 
“Plan Sheet” Model     (Typical, Detail, Summary, Plan, Single Profile Sheet Border) 
“Plan and Profile Sheet” Model     (Plan AND Profile or Double Profile Sheet Border) 
“Cross Section Sheet” Model     (Cross Section Border) 

 
File Types 

• CTY - County Map 

• DTL - Detail Sheet 

• PPL - Plan or Profile Sheet Layout 

• PLS - Plan Sheet 

• PRS - Profile Sheet 

• TSH - Title Sheet 

• TYP - Typical Sections 

• XPL - Cross Section Layout 

• XSS - Cross Section Sheet  
 
Example Files 
• R-2635C_RDY_CTY.dgn   (county map) 

Contains 
Design elements showing county map for project to use on Title Sheet 
Files Referenced 
N/A 

 
• R-2635C_RDY_DTL.dgn   (plan detail sheets such as Intersections) 

Contains 
Dimensions, Annotations in Design Model 
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Files Referenced   (all files needed to make a detail sheet) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_DSN.DGN   

(annotations, labels, dimensions, hatching, construction class design elements) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1) 

R-2635C_NCDOT_BDR.dgn  (Plan Sheet Model) 
 

• R-2635C_RDY_PPL.dgn   (master plan / profile sheet layout) 
Layout Named Boundaries into this file and write the plan sheets to the  
R-2635C_RDY_PLS_(Sheet Numbers).dgn file and write the profile sheets to the 
R-2635C_RDY_PRS_(Sheet Numbers).dgn file. 
 Contains 
 Only Sheet Named Boundaries in Design Model 
 Files Referenced   (all files needed to make a plan sheet) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_NCDOT_FS.dgn  (final surveys from Final Survey) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_AER.dgn  (aerial photography)  
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_DSN.DGN   

(annotations, labels, dimensions, hatching, construction class design elements) 
 R-2635C_RDY_ROW.dgn  (right of way from Final Survey) 
 R-2635C_RDY_SS.dgn   (slope stakes from CMD Nested 1) 

   
• R-2635C_RDY_PPL_PLS_004_THRU_014.dgn (plan sheets layout) 
Write the plan sheets to this file using the Named Boundaries from the R-2635C_RDY_PPL.dgn 
file 
 
 Contains 
 North Arrow and Matchlines in Design Model 
 Files Referenced 
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 R-2635C_RDY_PPL.dgn   (Default Model Nested Referenced)  
 Plan Sheet Border Cells 
 
 Contains 
 STIP and Sheet Numbers in the Sheet Model 
 Files Referenced 
 R-2635C_RDY_PPL.dgn   (Default Model Nested Referenced) 
   

 
• R-2635C_RDY_PPL_PRS_015_THRU_020.dgn  (profile sheets layout) 
Write the profile sheets to this file using the Named Boundaries from the R-
2635C_RDY_PPL.dgn file 
 

Contains 
 Annotations, Grid, Axis Labels in Design Model 

Files Referenced 
 R-2635C_RDY_PPL.dgn   (Default Model Nested Referenced)  
 

Contains 
 STIP and Sheet Numbers in the Sheet Model 
 Files Referenced 
 R-2635C_RDY_PPL.dgn   (Default Model Nested Referenced)  
 Profile Sheet Border Cells 
 
• R-2635C_RDY_TSH.dgn   (1 series sheets) 

Contains 
 Title Sheet     (Sheet 1) 
 Index of Sheets   (Sheet 1A) 
 Standard Drawings Listing  (Sheet 1A) 
 General Notes    (Sheet 1A) 
 Conventional Plan Sheet Symbols (Sheet 1B) 

Files Referenced 
 R-2635C_NCDOT_BDR.dgn  (Sheet Borders) 
  “Title Sheet” Model   (Title Sheet)  
  “Index of Sheets” Model  (Index of Sheets/Gen Notes/Standard Drawings) 
  “Conventional Symbols Sheet” Model (Conventional Symbols Sheet) 
 R-2635C_RDY_ALG.dgn  (Alignments) 
 R-2635C_RDY_CMD.dgn  (2D Design Elements) 
 R-2635C_HYD_DRN.dgn  (Drainage Design) 
 R-2635C_RDY_CTY.dgn  (County Map) 
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 R-2635C_RDY_CTY.dgn  (City Limit Boundary) 
 R-2635C_NCDOT_FS.dgn  (Final Surveys)  
 R-2635C_RDY_PPL.dgn  (Default Model Sheet Named Boundaries) 
 
• R-2635C_RDY_TYP.dgn   (Typical Sections)  

Contains 
Pavement Schedule 
Pavement Details 
Typical sections design elements 
Files Referenced 
R-2635C_NCDOT_BDR.dgn  (Sheet Borders “Plan Sheet” Model)    
     (Typical, Detail, Summary, Plan, Sheet Border) 

 
• R-2635C_RDY_XPL.dgn   (Cross Section sheets layout) 
Layout Named Boundaries into this file and write the cross section sheets resulting from the 
Named Boundaries into the R-2635C_RDY_XSS_(ALIGNMENT).dgn files. 
 
 Contains 
 Only Sheet Named Boundaries in the Design Model 
 Files Referenced    (all files needed to make a cross section sheet) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain from Final Survey) 
 R-2635C_RDY_ALG.dgn  (alignments from Alignments) 
 R-2635C_RDY_CMD.dgn  (master CMD file’s 2D & 3D models) 
 R-2635C_RDY_XPL.dgn  (3D Model containing Named Boundaries) 
 
• R-2635C_RDY_XSS_L.dgn   (Cross Section sheets) 
Write the cross section sheets resulting from the Named Boundaries into this file. 
 
 Contains 
 Design elements grid and axis labels in the Drawing Model 
 Files Referenced 
 R-2635C_RDY_XPL.dgn  (3D Model containing Cross Section) 
 
 Contains 
 STIP and Sheet Numbers in the Sheet Model 
 Files Referenced 
 R-2635C_RDY_XPL.dgn  (Drawing Models of Cross Sections) 
 Cross Section Sheet Border Cells 
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SAME QUESTION AS EARLIER FOR THE FILES BELOW.  THE FUNDAMENTAL QUESTION IS WHERE 

TO STORE SOMETHING LIKE FINAL PAVEMENT DESIGN, REQUESTED BY ROADWAY AND 

DESIGNED BY PAVEMENT DESIGN.  I PROPOSE THAT THE ORIGINAL STAYS IN A DESIGNATED 

FOLDER UNDER PAVEMENT DESIGN AND WE PLACE A LINK TO THAT DOCUMENT WITHIN 

PROJECTWISE IN OUR DOCUMENTATION FOLDER RATHER THAN COPYING IT.  THAT WAY THE 

OWNER KEEPS IT AND WE JUST “REFERENCE” IT JUST LIKE WE REFERENCE THE DRN FILE IN THE 

DRAINAGE FOLDER. DETAIL SHEETS COULD BE THE SAME.  HYDRO PRODUCES THE DRAINIAGE 

SUMMARY SHEETS IN THEIR FOLDER AND WE LINK TO IT TO SUBMIT IT WITH OUR PLANS.  

GEOTECHNICAL PRODUCES THE SUMMARY SHEETS IN THEIR SUBDIRECTORIES AND WE LINK TO 

IT AND SUBMIT IT THUS NOT HAVING MULTIPLE COPIES OF THINGS  

 
• R-2635C_RDY_DTL_2B.dgn  (Roadway Detail Sheets) 

Contains  
Design elements representing detail drawings of the project 
Files Referenced 
R-2635C_NCDOT_BDR.dgn  (Sheet Borders)  

 “Plan Sheet” Model (Typical, Detail, Summary, Plan, Single Profile Sheet Border) 
  
R-2635C_HYD_DTL_2C.dgn  (Other details) 
OR IN INDIVIDUAL UNITS’ FOLDER WITH LINK HERE? 
R-2635C_HYD_DTL_2D.dgn  (Drainage details) 
OR IN DRAINAGE FOLDER WITH LINK HERE ? 
R-2635C_GEO_DTL_2G.dgn  (Geotechnical details) 
OR IN GEOTECHNICAL FOLDER WITH LINK HERE? 
R-2635C_GEO_DTL_2H.dgn  (GeoEnvironmental details) 
OR IN GEOENVIRONMENTAL WITH LINK HERE? 
R-2635C_SMU_DTL_2N.dgn  (Structures wall envelopes) 
OR IN GEOTECHNICAL WITH LINK HERE? 
 

• R-2635C_RDY_SUM_3B.dgn  (Roadway Summary Sheets) 
Contains 
Design elements representing summary of quantities 
Files Referenced 
R-2635C_NCDOT_BDR.dgn  (Sheet Borders)  

 “Plan Sheet” Model (Typical, Detail, Summary, Plan, Single Profile Sheet Border) 
 R-2635C_HYD_SUM_3D.dgn  (Drainage Summary Sheets) 
OR IN DRAINAGE FOLDER WITH LINK HERE? 
R-2635C_GEO_SUM_3G.dgn  (Geotechnical Summary Sheets) 
OR IN GEOTECHNICAL WITH LINK HERE? 
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\Standards 

This folder contains standards files that are role-specific which therefore should not 
be stored in the NCDOT WorkSpace or the project-specific WorkSet folder.  It 
provides a folder location under the individual project to designate in the 
NCDOT_WorkSets.inp file when using NCDOT_USE_LOCAL_WORKSETS = L0  

 
File Extensions 
• .CEL  Cell library 
• .CFG  WorkSet configuration file 
• .DGNRL WorkSet sheet index file  
• .ITL  Template Library     
• .PLTCFG Plot Configuration File for Printing 
• .PSET  Print Organizer PrintSet for printing 
• .TBL  Pentable for Printing 
• .DGN  Design file 
• .DGNLIB Print Organizer Print Styles 

\Cell 
R-2635C_RDY.cel   

Contains 
 Custom cells if needed 

Files Referenced 
 N/A 

\Data 

\Dgnlib 

R-2635C_RDY_PRINT.dgnlib 
Contains 

 PEF specific Print Organizer print styles for PEF printers 
Files Referenced 

 N/A 
 
R-2635C_RDY.pltcfg 

Contains 
 Roadway custom plot configuration file 
 Recommended to copy WorkSpace .pltcfg to WorkSet directory, 

modify if necessary for the project and archive with the project   
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Files Referenced 
 N/A 
 
R-2635C_RDY.pset 

Contains 
 Roadway Print Organizer print set 

Files Referenced 
 N/A 

 
R-2635C_RDY.tbl  

Contains 
 Unit-specific customized pen tables for printing 

Files Referenced 
 N/A 
 

\Macros 

\Seed 

\Sheet Borders 

R-2635C_RDY_LOGO.dgn  
Contains 

 Company logo and address if project is PEF designed 
 Files Referenced 
 N/A 
 
R-2635C_RDY_SEAL.dgn   

Contains 
 PE Seal for the Roadway Design Engineer 
 Files Referenced 

\Superelevation 

\Symb 

HEY OAK CAN WE NAME THIS “SYMBOLS” IT’S THE ONLY FOLDER ABBREVIATED 

 N/A 
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\Template Library 

R-2635C_RDY.itl   
Contains 

 Roadway Design templates library 
 Files Referenced 
 N/A 

 

AWAITING TO SEE IF OAK MOVES THESE TO THE PROJECT LEVEL WORKSETS FOLDER 
 
• R-2635C_RDY.cfg  

Contains 
 Text file that designates where Roadway CADD files and Design Standards are 
stored 

Files Referenced 
 N/A 
 
• R-2635C_RDY.dgnrl 

Contains 
 Sheet index file for the Roadway project 

Files Referenced 
 N/A 
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Other Unit’s Subdirectories FILENAMES IN OTHER UNITS NOT DETERMINED 
These folders contain files commonly used by Roadway Design to obtain information needed to 
complete and present the design of a roadway. Some ORD filenames for other units have not 
been determined and this list does not represent all of the files needed to complete a roadway 
project  

 
Note the new name for the right of way file (TIP#)_NCDOT_ROW.dgn and new location for the right-
of-way file (ROW) under Final Survey.  The new workflow begins with Roadway Design creating the 
right-of-way file in the Final Survey folder, setting the right of way and easements, placing the 
monuments, and labeling them.  Location Surveys then uses the file to create their Right of Way Plan 
Sheets.  This results in a file created by multiple units resulting in the unit designation of NCDOT.      
   

\Common 

A folder located at Project Level where all units can access when coordinating with other units. 
 

OAK I STILL CANT THINK OF ANY CONTENTS FOR THIS FOLDER 

It’s not a place to put project milestone archives as it is used for now. You directed us to put 

those on our local server and only the latest goes to NCDOT.     

Because it’s at project Level, it’s not a place to put transmittals from other units to Roadway. 

Its not a place for PDF’s since we have a PDF folder where PDF versions of the milestone 

submittals will reside.  

I vote to not include it 

 

\Drainage 
 R-2635C_HYD_DRN.dgn  (hydraulics design) 
 R-2635C_EC_DSN.dgn   (erosion control) 
 

\Final Survey 
 R-2635C_LS_DTM.dgn   (from a V8i project converting to ORD) 
 R-2635C_LS_TIN.tin   (from a V8i project converting to ORD)   
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain model) 

R-2635C_NCDOT_FS.dgn (Final Survey file from Photogrammetry and Location Survey) 
 R-2635C_NCDOT_ROW.dgn   
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OAK I NAMED THE UNIT CODE “NCDOT” FOLLOWING THE PATTERN USED FOR THE FS 
FILE WHERE A COMBINATION OF UNITS CREATE A FILE (PHOTO AND L & S FOR THE FS 
FILE) AND (RDY AND L & S FOR THE ROW FILE).  
Contains   

 Right-Of-Way and Easement design elements and labels 
Files Referenced 

 R-2635C_EC_DSN.dgn   (erosion control from Drainage) 
 R-2635C_HYD_DRN.dgn  (hydraulics from Drainage) 
 R-2635C_LS or PH or NCDOT_ETM.dgn (existing terrain) 
 R-2635C_NCDOT_FS.dgn  (final surveys) 
 R-2635C_NEU_WEX(T).dgn  (wetlands from NEU) 
 R-2635C_RDY_ALG.dgn  (alignments from Roadway → Alignments) 
 R-2635C_RDY_AER.dgn  (aerial from Roadway →Design) 
 R-2635C_RDY_CMD.dgn  (master CMD file from Roadway →Design) 
 R-2635C_RDY_HIS.dgn (historic properties from Roadway →Alternatives) 
 R-2635C_RDY_HAZ.dgn  (hazardous sites from Roadway → Alternatives) 
 R-2635C_RDY_SIGHT.dgn  (sight distance from Roadway → Design)  
 R-2635C_RDY_SIGNS.dgn  (business’ relocated signs from Roadway →Design) 
 R-2635C_RDY_SS.dgn   (slope stakes from Roadway → Design Nested 1) 
 R-2635C_RDY_SUP.dgn  (superelevation from Roadway → Design) 
 R-2635C_SIG_POL.dgn  (signal poles from Signals) 
 “VARIOUS NAMES”.dwg  (site plans from Roadway → Design) 
 R-2635C_SMU_S1.dgn  (bridge general drawings from Structures) 
 R-2635C_UT_POW.dgn  (power from Utilities) 
 R-2635C_UT_SEW.dgn  (sewer from Utilities) 
 R-2635C_UT_WAT.dgn  (water from Utilities) 
 

\Geoenvironmental 
 R-2635C_GEO_DSN.dgn  (hazardous sites)  
 

\Geotechnical 
 R-2635C_GEO_DSN.dgn  (boring locations) 
 

\Natural Environment  
 R-2635C_NEU_WEX(T).dgn   (wetlands) 
 

\Photogrammetry 
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 R-2635C_PH.sid   (aerial photographs) 
 R-2635C_PH_ETM.dgn  (existing terrain) 
 

\Signals 
 R-2635C_SIG_POL.dgn  (wooden/metal poles and mast arms) 
 

\Signing 
 R-2635C_SGN_DSN.dgn  (sign designs) 
 

\Structures 
 R-2635C_SMU_S1.dgn   (bridge general drawings) 
 

\Utilities 
 R-2635C_UC_POW.dgn  (power designs) 
 R-2635C_UC_WAT.dgn  (water designs) 
 R-2635C_UC_SEW.dgn  (sewer designs) 
 

\Workset 

This folder contains standards files that are project-specific which therefore should not 

be stored in the NCDOT WorkSpace.  File such as the NCDOT standard border file BDR, 

are located in this folder and are shared and used by all roles.  

\Cell 

\Data 

\Dgnlib 

\Macros 

\Seed 

\Sheet Borders 
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• R-2635C_NCDOT_BDR.dgn 
OAK, I CALLED IT “NCDOT” BECAUSE I ASSUMED THAT ALL UNITS WOULD BE PULLING 
FROM THIS FILE TO GET THEIR SHEETS AND THE SHEETS WOULD HAVE CHANGEABLE 
ZONES TO FIT THE UNITS NEEDS. 
 
This file is to be assembled at the beginning of each project by creating the BDR file and 
models within the BDR file and placing the most current sheet cell in each of the models.  
The cells in the models can then be referenced to the design files that need a sheet border 
manually referenced to them such a Title, Typical, Detail, and Summary Sheets.  When 
sheet cells change over the life of the project, the old sheet cells can be replaced with the 
updated ones and that is reflected throughout all files that has these borders referenced.  
When the Preliminary or Right-Of-Way status designation needs to be removed from the 
plans, it can be accomplished in one file and that is reflected throughout all files that has 
these borders referenced.  
  

Contains  
 Common sheet borders in individual Models that the user manually reference to a 

design file for producing sheets other than the sheets automatically produced for 
plan, profile, and cross section layout. 

  
 “Title Sheet” Model (Title Sheet Border)  
 “Index of Sheets” Model    (Index of Sheets / General Notes / Standard Drawings Border) 
 “Conventional Symbols Sheet” Model     (Conventional Symbols Sheet) 
 “Plan Sheet” Model     (Typical, Detail, Summary, Plan, Single Profile Sheet Border) 
 “Plan and Profile Sheet” Model     (Plan AND Profile or Double Profile Sheet Border) 
 “Cross Section Sheet” Model     (Cross Section Border) 
 

\Superelevation 

\Symb 

HEY OAK CAN WE NAME THIS “SYMBOLS” IT’S THE ONLY FOLDER ABBREVIATED 

\Template Library 
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Create Design Files 

All new ORD Design Files for STIP projects are to be created and stored on NCDOT’s ProjectWise 

server.  New files for training can be created elsewhere such as the local C:\ Drive.  Creating 

design files outside of ProjectWise and moving them to ProjectWise is discouraged.  The ability 

to create additional folders under the NCDOT defined folders has been blocked.  Sorting files 

can be accomplished by assigning tags or metadata to the files.  Although NCDOT is using 

ProjectWise, NCDOT WorkSpaces and WorkSets are temporarily not being stored on 

ProjectWise.  This is referred to as Nonmanaged Workspaces.  While using Nonmanaged 

WorkSpaces, the Design Files will be created and stored on ProjectWise and will call the 

WorkSpaces and WorkSets from the C:\ Drive.  Once the user creates the design file and assigns 

a WorkSpace and WorkSet to the new design file, it is considered “branded” and when opened 

again, will open using the assigned WorkSpace and WorkSet if both are available to read.  It is 

the intention of NCDOT to store Managed WorkSpaces and WorkSets on ProjectWise in the 

future.  At that time, the procedure for creating Design Files will remain the same and they will 

call WorkSpaces and WorkSets on ProjectWise.   

As we begin using ORD where many things are located in a 3D model, it can be confusing 

whether to create a 2D or 3D design file.  The best “rule of thumb” to follow when creating 

design files is to ALWAYS CREATE AN ORD DESIGN FILE USING THE 2D SEED FILE UNLESS YOU 

ARE CREATING A FILE FOR PROCESSING SURVEY DATA OR CREATING A TERRAIN MODEL. 

 

 
Video 1-5 Creating Design Files on ProjectWise 

HTTP LINK PLACEHOLDER 
 

Create a Design File in ProjectWise 
A. Locate the ProjectWise Explorer Icon in your program listing, desktop start menu, or 

taskbar and select it to enter ProjectWise Explorer. 
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To access the subdirectories where files are stored on NCDOT’s ProjectWise Server, choose 

Tools → Network Configuration Settings. 
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B. Enter the following NCDOT datasource information and choose ADD in both the DNS 

Services and Datasource Listing tabs 
 

 
 
 

C. Your NCDOT Project Manager will create a STIP folder structure on ProjectWise under 
the NCDOT Production folder.  Locate the folder where your STIP project is stored and 
choose the subdirectory that you want to create a file in. 
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D. Choose Document → New → Document from the menu 
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E. Choose Advanced Wizard and OK on the Select a Wizard dialog.  Using the Wizard 
ensures that the file is set up properly with all of the necessary metadata assigned to it.  

 

 
 

• Alternatively, you can right click in the file listing pane and chose New → Advanced 
Wizard. 
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F. Choose Next to enter the Advanced Document Creation Wizard. 
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G. The current active folder will be highlighted.  Choose Next to select the current active 
folder to place your new design in or choose another target folder to create the new 
design file in and then choose Next. 
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H. ProjectWise needs a seed file to create the new design file from.  This seed file is located 
inside of the Managed WorkSpaces stored on ProjectWise at this location. 
 

pw:\\ncdot-pw.bentley.com:ncdot-pw-01\Documents\Administration\FINISH PATH  
 
NEED NCDOT TO PUT WORKSPACES UNDER PW ADMINISTRATION FOLDER TO CALL 
REVISE SCREENSHOT TO CALL PW 

 

 
 

I. Choose Browse and it will take you to the location of the seed files.  Remember to 
  

ALWAYS CREATE A 2D FILE UNLESS YOU ARE CREATING A FILE FOR SURVEYS OR A 
TERRAIN MODEL 

NEED NCDOT TO PUT WORKSPACES UNDER PW ADMINISTRATION FOLDER TO CALL 
REVISE SCREENSHOT TO CALL PW 
 
and Choose Seed2D – English Design.dgn and choose Open to begin creating a file. 
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J. Note that the seed file was populated in the dialog box and choose Next to complete 
the Select a Template dialog box. Note also that this template will be placed in the 
recent used templates for future ease of use. 

NEED NCDOT TO PUT WORKSPACES UNDER PW ADMINISTRATION FOLDER TO CALL 
REVISE SCREENSHOT TO CALL PW 
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K. If the Wizard is used, ProjectWise will communicate with NCDOT’s SAP program to 
gather information about the project and associate that data with the files that are 
created.  The Tip Number and Unit Name should automatically populate from SAP.  If 
not, you can manually enter this data and alert your NCDOT project manager to 
populate those fields in SAP.  Choose the Drawing Type from the pulldown area and 
choose Next to complete the Define Document Code dialog box. 
 
AWAITING ADVANCED DOCUMENT CREATION WIZARD TO BE FIXED BY BOB AND 
ELIZABETH AND FOR THE FILE TYPE LIST TO BE UPDATED BY BOB BEFORE I CAN REDO 
THIS SCREEN SHOT 
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The next dialog box will be populated according to your previous choices. Change the 

Application to OpenRoads Designer using the pull-down menu to associate this program to it 

for launching in the future from ProjectWise Explorer once NCDOT has moved to Managed 

Workspaces within ProjectWise.  Choose Next to complete the Document Properties dialog 

box.  BOB SHOW EXTENSION? YES BUT IT BROKE THE DIALOG ABOVE  
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L. Confirm the information is correct in the next dialog and choose Next to complete the 
Define Document Attributes dialog box. 
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M. ProjectWise is communicating with NCDOT’s SAP program to gather information about 
the project and associate that data with the files that are created.  This information 
should automatically populate in the next dialog box.  If not, alert your NCDOT project 
manager to populate those fields in SAP.  Choose Next to complete the Define 
Secondary Document Attributes dialog box. 
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N. Information gathered in previous dialog boxes is displayed.  Review the data to ensure 
accuracy and choose Next to complete the Create a Document dialog box. 

NEED NCDOT TO PUT WORKSPACES UNDER PW ADMINISTRATION FOLDER TO CALL 
REVISE SCREENSHOT TO CALL PW 
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O. Choose Finish to complete the creation of a file with the Advanced Document Creation 
Wizard. 
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P. A new file R-2635C_RDY_CMD.dgn will then be created in the chosen subdirectory. 
Note the ALL CAPITAL LETTERS. 

 

 
 

WHAT IS THE PROCEDURE FOR USERS TO GET PW BACKUPS? 
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Video 1-6 Creating Design Files outside of ProjectWise 

HTTP LINK PLACEHOLDER 
 

Create a Design File outside of ProjectWise 
A. Open ORD through the NCDOT Roadway desktop icon 

This Icon will open the DOT-US North Carolina workspace using the NCDOT and 
Roadway standards. Other desktop icons will use the same DOT-US North Carolina 
workspace but open with different standards from different units.  

 

 
 

B. When the ProjectWise Integration dialog box opens, choose Cancel to continue without 
communicating with ProjectWise. 

 

 
 

C. The following dialog box will appear. Choose the down arrow next to No Workspace 
and choose NCDOT’s overall workspace DOT-US North Carolina out of the dropdown 
box to assign to the new file. 
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D. Choose the down arrow next to the B-0000 WorkSet loaded with the workspaces and 
choose your WorkSet named after your STIP project number R-2635C that you created 
earlier under the Create WorkSet Files of this Module to brand your new file with. 

 

 
 

E. Choose the New File icon to create a new file. 
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F. The following dialog box will appear 

 

 
 

G. Choose the path to the location where you want to store your new design file.  In this 
case C:\NCDOT Training\Roadway\Module 1 - File Management\Roadway\Design 

 

 
 

H. Give your new file a name that conforms with the Naming Convention explained 
previously in this Module; in this case R-2635C_RDY_CMD.dgn. Note the use of all 
capital letters.   
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I. Follow the rule-of-thumb described previously in this Module, 
 

ALWAYS CREATE AN ORD DESIGN FILE USING THE 2D SEED FILE UNLESS YOU ARE 
CREATING A FILE FOR PROCESSING SURVEY DATA OR CREATING A TERRAIN MODEL. 

 
and ensure that the seed file is calling the 2D seed file from the WorkSpaces loaded on 
the local C:\ Drive.   
 
C:\MICROSTATION_CONNECT_WORKSPACE\Configuration\Organization-
Civil\NCDOT\Seed\Seed2D - English Design.dgn 

 
J. Choose Save to create your new design file and brand it with the chosen WorkSpace and 

Workset. 
 

 
 

K. Your new file will open in ORD. 
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Open Design Files 

Now that the WorkSpace has been set up, the WorkSet files for the project have been created, 

and a design file created, all of the supplementary files are now assembled to allow the user to 

open a design file.  Although NCDOT is using ProjectWise to only store design files and it is the 

intention of NCDOT to ultimately store WorkSpaces and WorkSets on ProjectWise in the future, 

NCDOT WorkSpaces and WorkSets are temporarily not being stored on ProjectWise.  This is 

referred to as Nonmanaged Workspaces.  While using Nonmanaged WorkSpaces, the 

Workspaces and WorkSets are stored outside of ProjectWise on the users C:\ Drive.  Since the 

workspaces are stored on the C:\ Drive, the user will NOT be using ProjectWise Explorer to 

enter design files.  Rather, the user will be using the NCDOT Roadway desktop icon to open 

ORD and use ProjectWise Integration to browse to the files they want to open.  This icon is to 

be used to properly enter ORD design files to ensure that NCDOT WorkSpaces and project 

WorkSets and called when entering the file.  These icons are temporarily necessary until 

Bentley allows Role designations under their workspaces that can be assigned to each 

discipline.   

 

 
Video 1-7 Opening Design Files 

HTTP LINK PLACEHOLDER 
AWAITING DECISION ABOUT WHICH VERSION(S) TO SHOW IN DOCUMENTATION BEFORE THIS 

ONE CAN BE RECORDED 
ASK JASON AND OAK  

1 – document opening totally projectwise explorer? 
2- document opening ms with projectwise integration ? 

3 – documentoutside of projectwise? 
 

Opening Design Files  
A. Locate the NCDOT Roadway ORD Icon loaded with the NCDOT WorkSpaces and 

manually copied to your desktop earlier and choose it to launch ORD to open a file. 
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B. On the ProjectWise Log in dialog box choose the NCDOT Production Datasource where 

your NCDOT project manager created your STIP project and choose Log In. 

 
 

Note that you can check the Remember me box to eliminate this step for this 
Datasource only. 

 
C. The following dialog box will appear.  If you are opening a design file for the first time, 

choose the down arrow next to No Workspace and choose NCDOT’s overall workspace 
DOT-US North Carolina out of the dropdown box to assign to the file. 
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D. Choose the down arrow next to the B-0000 WorkSet loaded with the workspaces and 
choose your WorkSet named after your STIP project number R-2635C that you created 
earlier under the Create WorkSet Files of this Module to brand your file with. 

 

 
 

 
E.  Choose Browse to open the ProjectWise file browser to be able to choose the design 

file located on the ProjectWise server. 
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Q. If your NCDOT project manager submitted your name to the ProjectWise administrator 
to grant you access rights to the files, then ProjectWise File Browser will open.  Note 
that a pre-defined custom column name scheme can be chosen for various units within 
the ProjectWise Browser by right clicking over the menu and choosing the unit name. 
This shows the columns that are anticipated to be needed or that unit’s files. Note the 
navigation buttons in the upper right to Show Folders, Navigate Back and go Up One 
Level. Choose a design file and choose Open to go into it. 

 

 
 

R. Choose the Use active Workspace, WorkSet to brand the file with this information and 
choose Open to Check Out a design file and go into it.  Checking out a file from 
ProjectWise makes you the owner of the file and no changes can be made to that file by 
another user until you check it back in. 
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S. ORD will read the file from ProjectWise, the WorkSpace and WorkSet from your C:\Drive 
and will and launch it in ORD. Note the blue notebook icon in the lower right corner. 
 

 

 

T. Choosing it confirms the WorkSpace and WorkSet that is branded to this file. 
 

 
 

U. Note the Ribbon Menus across the top that replaces the old tasks menus along the left 
side.  The user CAN add the task menus to the left side in ORD but those OLD task 
menus would only duplicate the commands in the ribbon and the old task menu would 
NOT contain all of the new commands introduced in ORD that are necessary for design.  
Therefore, save the space that would be taken up by these old task menus and learn 
the Ribbon.  You’ll appreciate that extra space when you have plan, profile, and cross 
section views on one screen at the same time.  
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V. Note the WorkFlow dropdown menu.  A WorkFlow groups various ORD commands 
logically according to the operation that needs to be accomplished.  Choosing different 
WorkFlows changes the Tab choices that are available below the WorkFlow dropdown 
box.  These Tabs contain the commands used to accomplish that WorkFlow. 

 

 
 

W. Note the Search Ribbon key-in field located at the top-right of the ORD user interface.  
It is useful to quickly find a desired command as you learn the ribbon interface without 
manually searching the ribbon.  As you key-in the name of a command, the Search 
Ribbon function will show a list of commands matching the text string as it is entered. 

 

 

 

X. Choose the File tab and ORD’s Backstage will appear where the user can choose Exit to 
exit the design file. 
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Y. Note the Red check mark next to the design file in the Check In dialog box indicating 

that it is still checked out from ProjectWise even though you have exited ORD.  Choose 

Check In to check in the file to ProjectWise thereby allowing another user to check it out 

and make changes to it. 
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Opening Design Files Troubleshooting 

A few of the common problems that occurs when trying to enter design files are summarized 

below. COVER OTHERS? 

 

Troubleshooting 
A. The following error occurs when you attempt to open a design file and the WorkSpace 

or WorkSet that it was branded with cannot be found by ORD.  Cancel out of the box. 
Follow the solutions below and reopen the file and this box should disappear.   
 

 
 
Possible solutions are: 

 

• Ensure that you have NCDOT WorkSpaces loaded at  
 

C:\MICROSTATION_CONNECT_WORKSPACE 

 

• Ensure that you have created a WorkSet for the project at 
 

C:\Projects\NCDOT 

 

• Ensure that the NAME?.zip file has been unzipped to overwrite the default .cfg file 
under Program Data.  See NCDOT ORD Workspace Setup under Additional Files 
Setup above in this Module. 
 

• Ensure that the NCDOT_USE_LOCAL_WORKSETS variable in the 
NCDOT_WorkSets.inp file on your desktop is pathed to where your WorkSets are 
located. 
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B. The following error (your version descriptions may vary) occurs when you attempt to 

open a design file in ORD that was created in a previous version of ORD.  Bentley 
releases new versions of ORD approximately every three months.  Some new ORD 
versions are minor version upgrades and few updates were incorporated resulting in 
the new version being able to open a design file created in a previous version.  Some 
new ORD versions are major version upgrades.  In order to open the old design file in 
the new version of ORD, it must be converted to the new version by choosing Yes.  As 
the dialog box says, a backup of the file using the old ORD version’s parameters will be 
created. 
 
The user should note that updating the design file to the latest version may not always 
be what the user should do.  If the file was created in the version that a specific entity 
such as another state uses and that entity has not upgraded to the current version 
loaded on the user’s machine, upgrading the design file, finishing the design, and 
turning it in to the entity would result in a design file that the entity could not open 
since the file was upgraded to a version one or more ORD versions ahead of that entity.  
If this is true, then the user should choose No which enters the design file in the old 
format read-only and does not upgrade it.   
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Copying Files from Windows to ProjectWise 

If the user needs to copy a file from Windows to ProjectWise, drag the file from Windows File 

Explorer over to the ProjectWise Explorer file listing pane.  When the Select a Wizard dialog 

box appears, choose Advanced Wizard, and follow the procedures outlined above for Create 

Design Files and Open Design Files on ProjectWise and the file will be copied into the 

destination folder in ProjectWise Explorer.    

 

 
Video 1-8 Copying Files from Windows to ProjectWise 

HTTP LINK PLACEHOLDER 
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Exporting Files from ProjectWise to Windows 

If the user needs to export a file from ProjectWise to Windows, this can be accomplished in 

ProjectWise Explorer. 

 
Video 1-9 Exporting Files from ProjectWise to Windows 

HTTP LINK PLACEHOLDER 
 
 

Exporting Files from ProjectWise to Windows 
A. Right-Click over the file in the ProjectWise Explorer file listing pane and choose Export. 

 

 

 

F. Choose Send to Folder – Creates unmanaged local copy and then choose Next.  
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G. Choose Browse and path to the destination folder.  Choose Next and the selected file as 
well as all of the reference files and nested reference files will be copied to the 
destination folder. 
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